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What is BSD LinkMan-E?  

BSD LinkMan-E is a linking software product that allows you to easily create, monitor and modify 
relationships between various representations of a building design project -- as drawn using 
Autodesk Revit, as specified using BSD SpecLink-E, and, in the future, as estimated using BSD 
CostLink/AE. This linking software is referred to as LinkMan-E or LME. The LME user interface is 
a set of “Dashboards,” together constituting a monitoring station that allows you to identify, control 
and coordinate relevant discrepancies between the three software applications. In short, LME is a 
tool for coordinating the Revit building model (the BIM), its specifications, and (in the future) its 
cost estimate. 
 
The building design and construction industry today is abuzz with the prospect of “building 
information modeling” or BIM, as the future of the industry. The focus and goal is the 
interoperability of industry software tools to create, maintain and utilize a common set of project 
information. This interoperability would benefit the industry in many ways, including the 
elimination or minimization of redundant data entry and substantial improvements to coordination 
between disciplines. While some interoperability proponents see all this project data as residing in 
a single repository, BSD believes that a single repository is not necessary, or even desirable in 
some cases, and has developed LME as an interoperability tool to enable these different software 
tools to communicate with each other without the necessity of merging their data. The initial 
implementation of LME links Autodesk Revit to BSD SpecLink-E (for specifications), but future 
implementations will include cost estimating (BSD CostLink-E), other 3-D graphical model 
software, and ultimately any other software that provides information about the project. 
 
The traditional mode of coordination between drawings and specs is to read the drawings, read 
the spec, and make them match. The same thing goes for coordinating the drawings and cost 
estimate or coordinating specs and cost estimate.  LinkMan-E uses software to match up things 
and to find things that don't match. The user decides how to resolve the mismatches and 
changes the drawings (3-D model) or the specs as required, using the software they reside in. 
LME also provides an option to change the specs from within LME, rather than having to switch to 
SLE to do so. 
 
LinkMan-E incorporates a tab that allows users to import, edit, and connect keynotes to Revit 
objects while simultaneously linking the objects to specifications in BSD SpecLink-E. A unique 
master keynote has been assigned to each of the thousands of products and assemblies in the 
LinkMan-E database, all of which have been linked to appropriate sections and paragraphs in 
BSD SpecLink-E. Objects in Revit have also been linked to the same LinkMan database, which 
permits LinkMan to display any discrepancies between a Revit project model and the 
corresponding project specifications in SpecLink – or to update the specifications automatically, 
based on the Revit data. 
 
The keynote tab in LinkMan-E allows users to import a file from Revit that displays all keynotes 
currently present in the Revit model. These keynotes are displayed adjacent to the corresponding 
master keynotes in LinkMan. The Revit keynotes can be edited or deleted in LinkMan-E, and 
LinkMan-E’s master keynotes can be copied individually to the Revit file or copied in total to any 
blank fields in the Revit file with a single click. The Revit user can then import this edited keynote 
file from LinkMan and assign it to the project. Any edited keynotes will automatically replace any 
that are currently in use in the Revit model, and all the additional LinkMan master keynotes will be 
available for use in the project. 
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SpecLink-E / LinkMan-E User Scenarios 

User scenarios range on a continuum from minimal integration -- amounting to just barely beyond 
word processing specs and CAD -- to highly advanced -- full "BIM" implementation and office 
masters in SpecLink-E. Many organizations are or will be progressing along this continuum, some 
gradually, others in fits and starts. 
 

Minimal Integration: The spec is prepared last, ind ependently of 
the 3-D model 

The specification preparer, whether an in-house employee or a consultant, is often physically 
remote from the Revit modeler and the cost estimator. The spec writer uses the Assembly and 
Products dashboards in LinkMan-E (LME) to identify assemblies that are used in the Revit model 
and corresponding products he needs to specify. The spec writer then uses the SLE dashboard 
to either identify the spec sections and text that he needs to include, switching to SLE itself to do 
that, or uses the LME dashboard to actually "turn on" the relevant spec text. 
 
Some cooperation of the Revit modeler is necessary, to get the LME equivalent of the Revit 
objects loaded into LME's Revit Project view and subsequently re-synchronized, but the Revit 
modeler needn't know anything else about LME or SpecLink-E. The spec writer can review the 
names of the actual Revit objects and link them to LME assemblies if necessary. If the Revit 
modeler has used Autodesk -provided objects that BSD has pre-linked to LME, the spec writer 
need make no other links. If custom Revit objects are used, and the spec writer has no access to 
the actual Revit project via the Revit software or a viewer, the internal details of the objects will 
not be visible - that data would have to be acquired verbally.  
 
In the long run, the spec writer would reduce production time by using the LME dashboards to link 
his SLE office master for this client or project type to an LME office master project of the same 
type for re-use on multiple projects. LME provides for user-added assemblies, products, and links 
to be available in other projects, not just the project they were generated in. 

Advanced Integration: The specification and the 3-D  model are 
prepared in parallel, both from master "libraries" 

The architect or other design professional has developed an "office library" of Revit building 
objects and has linked them to LME. The specification writer has prepared one or more "office 
masters" in SLE and linked them to LME. The Revit modeler builds his model by using as many 
of the "pre-linked" objects as possible -- either the Autodesk-provided objects or those from his 
office library. He may begin with "generic" objects that have little internal detail and later change 
these to more detailed objects as the design progresses. The Revit modeler doesn't pay much 
attention to LME at first and in many cases will not even have it running. 
 
When the model is sufficiently developed to provide useful information to the spec writer, the 
Revit modeler connects the Revit project file to LME and the spec writer connects the appropriate 
SLE office master file to LME. Both the specification writer and the Revit modeler, and possibly 
the project manager, use the LME dashboards for coordination review. When they open LME, the 
dashboards show the status of Revit objects and SLE sections and text, plus the relationships 
between them. 
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The LME Revit Project view quickly identifies any Revit objects that are not linked to an LME 
assembly. The LME Assemblies Dashboard quickly shows the products to which each assembly 
is linked, plus identifies assemblies not linked to any products. The LME Products Dashboard 
shows which products are already included in the specification and which are not. All the 
dashboards can be set to show only "discrepancies" - for instance, where Revit shows an object 
but SLE shows no specs, or where SLE shows a spec for a product that is apparently not used in 
the Revit project. After resolving the obvious discrepancies, verbal communication is likely to be 
necessary to reconcile other discrepancies shown. 
 
As in the minimal integration scenario, the spec writer either switches to SLE itself to edit the 
specs or uses the LME Products Dashboard to actually "turn on" the relevant spec text. The Revit 
modeler must use Revit itself to modify the project objects, if necessary. Under some 
circumstances it may be unnecessary to modify an actual Revit object if the LME Assembly it is 
linked to is also linked to the proper products. The spec writer could also change the LME 
Assembly to which a Revit object is linked in order to make more detailed links to the 
specification. 

LinkMan-E Data Structure Schematic 

 

How LinkMan-E links to Revit 

LinkMan-E uses the Category, Family, and Type identifications of Revit objects to associate them 
with LME Assemblies. The Category is the first level title in the Project Browser folder tree below 
"Families." The Family and Type names are those that show in the Revit Type Properties box 
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(and in the folder tree). Note: Revit has a few idiosyncrasies in Category naming, making the 
Revit View in LME not an exact match for the Revit Project Browser view. This does not interfere 
with linking. 
 
All the Families and Types in the Revit Architectural 2009 through 2012 Imperial Libraries and the 
out-of-the-box template files have been "pre-linked" to LME assemblies -- except where the Revit 
object is too general or sketchy to identify what materials it is made out of. If an Autodesk-
provided object is used in a building model as-is -- without changing any of the parameters that 
would force Revit to make a copy -- then LME will know about it automatically. 
 
If a custom object is made by duplicating an Autodesk-provided object, the copy must be given a 
different Type name (Revit's rule). LME will see it but will not "recognize" it. The same goes for 
custom objects made in other ways -- Revit will not allow duplicate Category/Family/Type 
identifications. For all custom objects, once the Revit data has been updated in LME, the Revit 
objects will show in the LME Revit Project view, but without any link to an LME Assembly. To 
connect the custom Revit object to LME, simply drag-and-drop it to any assembly in the 
Assemblies Dashboard. If an existing LME Assembly is suitable you can use it, as it is already 
linked to products and thus the specification. If necessary, you can also quickly build a new LME 
Assembly for the purpose. 
 
LME also includes a Revit Keynote Management System. 

How LinkMan-E links to SpecLink-E 

Since SpecLink-E, like most specifications, deals with products as opposed to assemblies of 
products, LME includes a master list of generic product names in the Products Dashboard. There 
is a one-to-one relationship between the products in the Products Dashboard and product 
paragraphs in the SpecLink-E database. In some cases, where a single generic product could be 
specified in more than one specification section, the generic product name in the Products 
Dashboard indicates the specification section that particular product entry applies to. (You can 
see some of these by placing the cursor on the folder Facility Construction Subgroup - Divisions 
02 through 14 in the Products Dashboard and reviewing the alphabetical list of generic product 
names displayed -- the section number appears in parentheses at the end of the generic product 
name.) 
 
The second thing LME does to link to the specs is to associate a set of generic products with 
each LME Assembly. In the Assemblies Dashboard, click on an assembly -- the products 
associated with it are displayed in the sub-window at the bottom. This is the way that LME 
bridges the "gap" between Revit objects -- which are usually assemblies of multiple products -- 
and the individual products that are described in the specifications. 
 
When the you use Synchronize to activate links to the SpecLink-E project, an activated paragraph 
in the SpecLink-E project will automatically select its parent, which will select its parent, all the 
way to the top of the section, so that activating a lower level paragraph in a SLE section can 
activate the entire section. These links are currently invisible in SLE. 



 
 

5   

Installation and Setup 

For the most current installation instructions see the updated installation document on our 
Download Center. 

Hardware and Software Requirements  

·  LinkMan-E runs on 32-bit and 64-bit Microsoft Windows environments on Intel-based 
personal computers. The following describes the hardware and software requirements to 
operate the software.  

·  As with any Windows-based application, faster system components and more system 
memory enable faster performance.  

·  The speed of the server disk drive is important since the server portion of both SpecLink-
E and LinkMan-E is a database-based system.  

·  Use of a higher resolution video card and monitor enables more information to be 
displayed on the screen.  

   
Recommended server configuration  

·  LinkMan-E requires a SpecLink-E Server or Standalone installation and requires a valid 
LinkMan-E access key.  

·  Requirements for that server are unchanged by the installation of LME. Please see the 
description of SpecLink-E requirements for details.   

 
Recommended client configuration  

·  Intel-compatible processor, 2 GHz or better  
·  Windows™ 7, Vista or XP  
·  2 GB of RAM  
·  1 GB of available disk space  
·  XGA or higher resolution monitor  
·  Internet Explorer 8.0 or higher  

 
Recommended laptop or standalone configuration (whi ch will run both server and client 
applications)  
In this configuration, the computer will likely be running Autodesk Revit Architecture, SpecLink-E 
standalone version and the LinkMan-E installation simultaneously, not to mention an email 
program and other tools as well. Be sure to review the requirements for running Revit. 
Recommended configuration for SLE and LME includes the following: 

·  Intel-compatible processor, 2 GHz or better  
·  Windows™ 7, Vista or XP  
·  4 GB of RAM recommended 
·  10 GB recommended available disk space  
·  XGA or higher resolution monitor  
·  DVD reader (Corporate version of SLE only) 
·  Internet Explorer 8.0 or higher  

   
No other software is required.  

Downloading the software  

The LinkMan-E application may be downloaded from our web page at our Download Center.   
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1. From our home page (www.bsdsoftlink.com) click on For Customers. 
2. Click on Download Center. 
3. Find the download link. 
4. Save the file to a temporary folder on your computer.  
5. Be sure to download the current Release Notes . 
6. Once downloaded to your computer, close all open applications. 
7. Double click on the downloaded file to start the installation. 
8. Follow the instructions on-screen. 

 
Note:  The download file may be large and may take some time, depending on the speed of your 
connection to the Internet.  
 
For more information on installing the software, download the Installation Instructions  file from 
the same location or call Technical Support at 800-266-7732. 

Running LinkMan-E over a Wide Area Network (WAN) 

As an SQL application, LinkMan-E allows you to access the server part of the application over a 
Wide Area Network (WAN) or a Virtual Private Network (VPN). See the installation instructions on 
our web page for instructions on configuring your computer to run LinkMan-E over a WAN or a 
VPN. 

Moving or Uninstalling the Software 

The Master and LME Groups database part of LinkMan-E is tied to the server location of 
SpecLink-E, so LinkMan-E must be moved if SpecLink-E is moved. See the Installation 
instructions on the Download Center for detailed instructions on moving a Network Server or 
Standalone installation of SpecLink-E. 
 
When you Backup or restore the databases in SpecLink-E, that includes the LinkMan-E 
Master and LME Groups databases. 
 
The basic steps when you have a server and client installation include: 

·  Backup your databases in SLE.  
·  Get an Unpermit code from BSD Technical Support. 
·  Uninstall the BSD LinkMan-E Server Components.  
·  Uninstall the BSD SpecLink-E Server Components.  
·  Remove the SLE Client Setup folder.  
·  Remove the LME Setup Packages folder. 
·  Have each client Uninstall both BSD SpecLink-E and BSD LinkMan-E.  
·  Perform the server installations for SLE and LME at the new server.  
·  Perform the client installations for SLE and LME at each client machine, using the 

new location of the SLE Client Setup folder and the LME Setup Packages folder.  
·  Perform the Revit Plugin installation at each client machine. 
·  Restore the backed up databases using SLE Support Utilities (available at the server) 

on the Building Systems Design group on the Start Menu 
·  Input new EIDs.  
·  Have each client open Revit and use Set Server Name. 

 
Moving the software from one Standalone machine to another. 

·  Backup your databases in SLE.  
·  Get an Unpermit code from BSD Technical Support. 
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·  Uninstall the BSD LinkMan-E Server Components.  
·  Uninstall the BSD SpecLink-E Server Components.  
·  Uninstall both BSD SpecLink-E and BSD LinkMan-E.  
·  Remove the SLE Client Setup folder.  
·  Remove the LME Setup Packages folder. 
·  Perform the standalone installations for SLE and LME on the new computer.  
·  Restore the backed up databases (including both the SLE and the LME Masters) 

using SLE Support Utilities on the Building Systems Design group on the Start Menu. 
·  Input new EIDs.  
·  Open Revit and use Set Server Name. 

 

Set Server Name 

This command is available in LinkMan-E as well as Revit. Both applications should be set to the 
same server. In LinkMan-E it is only available when you do not have a LME Group open. Use this 
to redirect LinkMan-E or Revit to use a different location for the server part of the application. This 
might be necessary if you have moved the server part of the application to a new server.  
 
To use Set Server Name in LinkMan-E: 

·  Close your open LME Group 
·  Click on the Tools tab 
·  Click on Set Server Name 
·  Type the server name in the Server Name / IP Address field 
·  Click on Save 
·  LinkMan-E will restart using the new server name  

 
To use Set Server Name in Revit: 

·  Open a Revit Project 
·  Click on the Add-Ins tab 
·  Click on Set Server Name 
·  Type the server name in the Server Name / IP Address field 
·  Click on Save 
·  Restart Revit for the change to take effect  

 
Port Number : Note that the Port Number for LinkMan-E is typically 9049.  Contact BSD 
Technical Support at 800-266-7732 if you need to change the port. 
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Software Orientation 

2007 Microsoft Office Ribbon Bar Menus 

 
 
LME uses the 2007 Microsoft Office ribbon bar menus. The primary components are: 
 

·  Application Menu  (LinkMan-E logo, on top left of application window) -- Includes global 
commands.  

·  Ribbon  -- This is the primary placement for menus and toolbars. The Ribbon can be 
minimized by right-clicking on the ribbon or double-clicking on any tab name. When 
minimized, the ribbon bar will reappear when you click on a tab and select a function. 
Once you have done that, it will disappear again until you click on another tab.  

·  Tabs -- are used to organize controls in the Ribbon.  An example is the Home tab, where 
many commonly used commands are placed. We have 3 tabs including Home, 
Applications, and Tools. 

·  Groups  -- Each tab contains one or more groups. (Assemblies Dashboard is a group on 
the Home tab.) 

·  Quick Access Toolbar  -- The Quick Access Toolbar is a row of small icons at the top of 
the application. You can right-click on any command to add it to the Quick Access 
Toolbar.  

·  Help  -- The Help is accessed by clicking on the small green circle with the question mark 
on the top right corner of the application. 

Tool Tips 

To see what an icon or symbol means, let your cursor hover over the icon or symbol, and you 
will see a tool tip with an explanation. 

Auto-hiding the tree 

The Project Tree window can be hidden so that it disappears to the left of the screen and 
reappears when you let the cursor hover over the tab on the left side of the application window. 

·  To hide the tree click on the pushpin icon in the top right of that panel. 
·  To view the tree, let your cursor rest on the tab and it will slide into view. 
·  To keep the tree in view, click on the pushpin icon again. 

Views in the LME Project Group   

These are the views in LME that display the status of objects in each of the linked applications.  
·  The Products Dashboard and the Assemblies Dashboard views display the status of 

objects across applications - allowing you to confirm discrepancies between the data in 
SLE and the data in Revit.  
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·  The Revit Project view shows the status of assembly objects in the Revit project.  
·  The SpecLink Project view shows the status of products in the SpecLink-E project.  
·  The Keynotes tab displays the keynotes in the LME master database as well as those 

added by the user.  
·  The Revit Materials tab displays the all of the materials available in the Revit project. 

 

My Start Page 

 
 
When you open the software, the first tab is populated by My Start Page, which opens the 
Building Systems Design LinkMan-E web page. This page includes the most up to date 
information about LinkMan-E. When you click on a link within this page, if you want to go back to 
the previous page, use the Back icon in the My Start Page group of the Home tab. Use the 
Forward icon to go in the other direction. 



Software Orientation 
 

11   

Products Dashboard 

 
 
The Products Dashboard shows the status of LME products in all linked applications.  
   
To see all products whether they are active in any linked applications, click on Show All Objects 
on the Applications tab.  
To see only products that are active in at least one of the linked applications click on Show Active 
Objects on the Applications tab.  
To see products that are active in one linked application but not in another, click on Show 
Discrepancies on the Applications tab.  

·  Products Dashboard Tree  - If you click on the Facility Construction Group folder in the 
Products Dashboard Tree, which is organized by MasterFormat 2004, you will see all of 
the products in divisions 2 through 14. If you click on a lower level folder in the Products 
Dashboard Tree, you will see only those products linked to objects under that folder. 

·  Left most box  - The box to the left of the Product Name will be shaded in blue if the 
Product has been added by the user. 

·  Product Name - This is the description of the product in the LME database. 
·  Select Specs  

·  A green background in this column indicates that the product has been selected 
by the Auto Select Specs command.  

·  A checkmark in this column indicates that this product has been selected by a 
single click to initiate links to activate text in the SpecLink-E project.  

·  An X in this column indicates that the user has elected to exclude that paragraph 
within the SLE Project.  

·  A white background in this column indicates that there will be no link action taken 
on the target of this Product.  

·  See Activating SLE paragraphs and sections. Once the products have been 
selected or excluded, the next step would be to Synchronize. 

·  SpecLink-E  
·  A gray status box in this column indicates that this product is not currently active 

in the SLE Project.  
·  A bright green color in this column indicates that this product is active in the SLE 

Project.  
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·  A lighter green color indicates that this paragraph has a green link to it in SLE but 
it is not active because its parent is not active. 

·  A yellow triangle in this column indicates that this product is linked to an SLE 
paragraph that has a yellow link in the SLE project. 

·  A red stop sign means that this product is excluded in the SLE Project. 
·  Revit Model  

·  A gray status box in this column indicates that this product is not currently active 
in the Revit Project.  

·  A green color in this column indicates that this product is active in the Revit 
Project. 

·  CostLink/AE  – In the future, this column will reflect the status of the CostLink/AE project. 
·  LME Keynote #  - Displays the keynote number for the keynote that is associated with the 

LME Product.  
·  LME Keynote Text  - Displays the keynote text for the L-Keynote # described above. 
·  Assembly Name  - The bottom panel displays the assemblies that contain the currently 

highlighted product.  See Assemblies Dashboard for more information about the 
assemblies. 
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Assemblies Dashboard   

 
 
The Assemblies Dashboard shows the status of assemblies in each of the linked applications, 
allowing you to see correlations and mismatches.  
   
To see all assemblies whether they are active in any linked applications, click on Show All 
Objects on the Applications tab.  
To see only assemblies that are active in at least one of the linked applications click on Show 
Active Objects on the Applications tab.  
To see assemblies that are active in one linked application but not in another, click on Show 
Discrepancies on the Applications tab.  

·  Assemblies Dashboard Tree  - If you click on the SHELL folder in the Assemblies 
Dashboard Tree, which is organized by the Uniformat breakdown, you will see all of the 
assemblies within the SHELL folder and any subfolders. If you click on a lower level 
folder in the Assemblies Dashboard Tree, you will see only those assemblies linked to 
objects under that folder. 

·  Left most box  - The box to the left of the Description will be shaded in blue if the 
Assembly has been added by the user. 

·  Description  - This is the description of the assembly in the LME database. 
·  SpecLink-E  

·  A gray status box in this column indicates that none of the products in this 
assembly are currently active in the SLE Project.  

·  A green color in this column indicates that all of the products in this assembly are 
active in the SLE Project.  

·  A yellow triangle indicates that one or more (but not all) of the products in this 
assembly is active or has a yellow link in the SLE Project. 

·  A red stop sign means that at least one of the products in this assembly are 
excluded in SLE 

·  Revit Model   
·  A gray status box in this column indicates that this assembly is not currently 

active in the Revit Project.  
·  A green color in this column indicates that this assembly is active in the Revit 

Project.  
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·  Quantity  - This column reflects the quantity of this assembly in the Revit project for the 
highlighted folder. 

·  CostLink/AE  - In the future, this column will reflect the status of the CostLink/AE project. 
·  Quantity  - In the future, this column will reflect the status of the CostLink/AE project. 
·  LME Keynote #  - Displays the keynote number for the keynote that is associated with the 

LME Assembly.  
·  LME Keynote Text  - Displays the keynote text for the L-Keynote # described above. 

Products within Assemblies  - When you click on an individual assembly within the Assemblies 
Dashboard view, the bottom part of the right hand screen will display information about the 
Products within that assembly. See Products Dashboard for more information on this display. 
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Revit Project Tab   

 
 
The Revit Project tab displays data about Revit objects that are present and active in the Revit 
project, as well as objects that are included in the LME master data. 

·  Revit Project Tree  - The folders in the Revit Project Tree reflect the hierarchy of the 
Revit project. Click on the plus sign to see sub-folders below higher level folders. When 
you click on a folder, the status columns to the right reflect the condition of the 
assemblies within that folder. If you click on the very top folder (Revit project name) you 
will see all objects in Revit, depending on your setting of Show All Types or Show Active 
Types. 

·  Status  - The lighter background and green color in the Status column indicate that the 
assembly is present in the Revit project. 

·  Category and Family - These fields come from the hierarchy in the Revit project. 
·  Type - This displays the name of the assembly in the Revit project. 
·  # of Instances  - This displays the number of instances of this assembly in the Revit 

project. 
·  Quantity  - This column shows the total quantity for all of the instances of this assembly. 
·  Linked  - A checkmark indicates that this Revit object is linked to one or more 

assemblies. A yellow triangle background indicates that this Revit object is linked to more 
than one assembly. Right click on a Revit Object to view the links. Objects included in the 
master database are linked already. User added Assemblies and Products need to be 
linked by the user. See linking user added products and assemblies. 

·  R-Keynote #  - Displays the keynote number for the keynote that is currently assigned -- 
or the keynote that is ready to be assigned by LME. 

·  R-Keynote  - Displays the keynote text for the keynote that is currently assigned -- or the 
keynote that is ready to be assigned by LME. 

·  L-Keynote #  - Displays the keynote number for the keynote that is currently assigned to 
the LME object this Revit element is currently linked to. This is a suggested keynote from 
the LME master or from an LME object that you have created. This keynote number can 
be transferred to the R-Keynote column singly (with a right mouse button click) or as a 
batch process using the Apply Default Keynotes in the Autodesk Revit group on the 
Applications tab. 
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·  L-Keynote  - Displays the keynote text for the L-Keynote # described above. This can be 
transferred to the R-Keynote column singly (with a right mouse button click) or as a batch 
process using the Apply Default Keynotes in the Autodesk Revit group on the 
Applications tab. 

·  Materials  - When each Revit object is highlighted, any related Materials will be displayed 
in the bottom part of the right hand window. 
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SpecLink Project Tab   

 

The SpecLink Project tab displays the status of the products in the specification. 

SpecLink Project Tree  - The SpecLink Project Tree reflects the hierarchy of the SpecLink-E 
project. Click on the + sign to see sub-folders under higher level folders. When you click on a 
folder, the status columns to the right reflect the condition of the products within that folder. If 
you click on the project name (top folder in the tree) you will see all of the products for the 
project (depending on your setting of Show All Products or Show Active Products). 
Paragraphs that are tagged as PL in SpecLink-E will appear in the SpecLink Project tab. SLE 
paragraphs will not appear in the SpecLink Project Tab until something has been activated in 
that section, or you have opened that section in SLE. A page icon in the tree indicates that 
the folder contains a link within the LME Group. It may be a link to exclude, rather than 
include, a section, so the page icon in LME is different than the page icon in SLE in that it 
does not always represent an active section in the SpecLink-E project. 

·  Left most box  - The box to the left of the Section ID will be shaded in blue if the 
SpecLink-E paragraph is a user added paragraph or a user modified master paragraph.  

·  Section ID  - This column displays the Section ID and acronym for the section that 
contains the paragraph in SLE that references this product. 

·  Seq# - This column displays the sequence code from the paragraph in SLE that 
references this product. 

·  Status  - The lighter color background and the green color indicates that this product is 
specified in the SLE project.  

·  A gray status box indicates that this paragraph is not active in the SLE project. 
·  A yellow triangle indicates that this product has a yellow link in the SLE project. 

but is not active.  
·  A red stop sign indicates that this product is excluded in the SLE project. 

·  Description  - This column displays the text of the paragraph in the SLE project.  
·  Linked  - A checkmark in the Linked column indicates that the product has been linked to 

an object in LME. Products that are included in the master database are linked already. 
Right click on a line to see the link for that product. A SLE paragraph can only be linked 
to one Product. User added Products need to be linked by the user. See linking user 
added products and assemblies. 
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Revit Materials Tab   

 

The Revit Materials tab displays all of the materials available in the Revit project. Since Revit only 
stores the keynote number in the object (not the keynote text) the R-Keynote column may be 
empty if a keynote was applied in Revit, but that keynote file was not imported into LME. In LME, 
keynotes can be applied to materials, as well as Revit objects. In LME, you can drag and drop 
from the Keynotes tab to the Materials tab, in the same way that you can drag and drop Keynotes 
onto an element in the Revit project tab. In addition to the Revit Materials tab, the associated 
materials are now also displayed in the bottom half of the screen when you click on a Revit 
element that has a material assigned to it.  

See Keynotes section later in this manual for a des cription of the fields in the Keynotes 
tab.
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How To.... 

Start a new LME Group 

Starting a New LinkMan-E Group  

To start a new LME Group:  

1. From the Application menu choose New LME Group. 
2. Enter a name for your new LME Group and click Create. 
3. The new LME Group will be created and the Products Dashboard and Assemblies 

Dashboard will open.  

   
To connect your new group to a SpecLink-E project use Connect  SpecLink-E Project.  
To connect a Revit project to your new group, see Connect Revit Project to your LME Group.  

LME Group Naming  

The name of the LME Group (the name you enter when you first create the LME Group) should 
be a meaningful name that is easily recognized by other team members.  The LME Group name 
is visible to others using the same LME Groups database that you are.  

System Group ID 

Each time you create a new LME Group, the software assigns a unique System Group ID, which 
can help you to distinguish between groups with the same or a similar name. In many cases, this 
System Group ID follows the LME Group Title to help you identify your project. 

Connect your Revit Project to your LME Group  

To connect a Revit project to your LME Group:  

1. Open Revit. 
2. Open the Revit project that you wish to connect to your LME Group. 
3. Click on the Add-Ins tab/LinkMan-E Group and select Connect to LinkMan-E Group. 

(Note: If the LinkMan-E group on the Add-ins menu does not appear available, you may 
need to change your Revit project to the default 3D view on the View tab.) 
 

 
 

4. After selecting the LME Group and clicking OK, you will receive a confirmation that the 
Revit Project has been connected to the LME Group. 

5. In the LinkMan-E group in Revit, click on Update LinkMan-E data. 
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6. You will receive a confirmation that the data has been successfully updated. 
7. In LME, click on Refresh in the Applications tab. 

A Revit project may connect to only one SLE project at a time. When you select Connect to 
LinkMan-E Group, if the Revit Project is already connected to an LME Group, the currently 
connected LME Group will be highlighted. You can select another LME Group.   

Revit Menu Commands  

The following commands are available from within your Revit Project. To use the commands, 
click on the Add-Ins tab/LinkMan-E Group.  

·  Connect to LinkMan-E Group 
·  Update LinkMan-E Data - This command sends the most current information from this 

Revit project to the LME Group with which this project is connected. Use this command 
any time you have made changes to your Revit project that need to be reflected in your 
LME group. You will receive a confirmation when the process is complete. 

·  Import/Replace Keynotes - This brings the LME Keynote information into your Revit 
project. For more information, see the Keynote section later in this manual. 

·  Set LinkMan-E Server Name 
·  About LinkMan-E - This displays the current version of LME, as well as the server 

location 

Note: If the LinkMan-E group on the Add-ins menu does not appear available, you may need 
to change your Revit project to the default 3D view on the View tab. 

Connect SpecLink-E Project  

 
 
To connect a SpecLink-E project to your LME Group:  

1. From the Application menu choose Connect SpecLink-E Project. 
2. Select the project to connect and click on Open. 
3. The selected SpecLink-E project will be connected to your LME Group. 
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Note: If your LME Group is currently connected to an SLE Project, you need to use Disconnect 
SpecLink-E Project first.  

Disconnect SpecLink-E Project  

To disconnect a SpecLink-E project from your LME Group:  

1. From the Application menu choose Disconnect SpecLink-E Project. 
2. To connect a different project, use Connect SpecLink-E Project. 

Summary Info  

 
 
To open the Summary Info dialog box, click on Summary Info from the Application menu or click 
the Summary Info icon on the Quick Access toolbar.  
   
Here you can view the:  

·  LME Group ID 
·  LME Group Name 
·  LME Group Member Projects 

To change the Group Member projects, see Connect SpecLink-E Project and/or Connect to Revit 
Project. 

Open LME Group 

To open an existing LME Group:  

1. From the Application menu choose Open LME Group, or select the name of the group 
from the list of Recent Groups that appears to the right of the menu. Groups that have 
been opened on this computer are listed. If the Group you want to open is not listed, click 
Open LME Group from the Application menu button to find it. 

2. When the selection dialog box opens, click on the name of the group and click Open.  

Tips:  
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·  If you are not sure which LME Group you want to open, click the Details option on the 
right. The LME Group Name, System Group ID (assigned by the software noted in 
parentheses) and last edited date will appear for all groups. You can sort by any of these 
columns by clicking on the column label at the top.  

Close LME Group   

To close the LME Group without exiting the program:  

1. Click on the Application menu.  
2. Choose Close LME Group.  

   
To close the LME Group and exit the software at the same time:  

1. Click on the X in the top right corner of the application. 

LME Groups Database 

Your LinkMan-E Groups are stored in a single database, in the same location as your SpecLink-E 
Projects Database. In a multi-user situation, this database will be on a server to which all users 
have access. The database location is determined during the SpecLink-E installation process. 
The LME Groups database also stores any user added Products, Assemblies and links. 
 
The LME Groups database has a size limitation of 4 GB. 

Basic Steps   

The basic steps to review and modify relationships between your Revit and SpecLink-E projects 
include:  

1. Create a new LinkMan-E Group. 
2. Connect to your SpecLink-E project. 
3. Connect your Revit project to the LME Group. 
4. Click on the Assemblies Dashboard to view the LME assemblies and their status in both 

the Revit and the SpecLink-E projects. 
5. Use Show All Objects, Show Active Objects, and Show Discrepancies as needed. 
6. Click on the Products Dashboard to view the LME Products and their status in both the 

Revit and the SpecLink- E projects. 
7. Use Show All Products, Show Active Products, Show Discrepancies, Auto Select Specs, 

Activate SLE paragraphs and sections and Synchronize as needed.. 

To make use of the Keynote Management System, see Revit Keynote Management System and 
Revit Keynote Management Basic Steps.  
 
The basic steps for adding to the LME database are:  

1. Create Products as needed. 
2. Create Assemblies as needed. 
3. Add links as needed. 
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Activating SpecLink-E paragraphs and sections 

LinkMan-E can be used to make selections of paragraphs and sections in SpecLink-E. To turn on 
paragraphs in SLE:  

1. The SLE paragraph to become activated must be tagged as PL (Product Listing). This 
can be a master paragraph or a user added or copied paragraph that has been tagged as 
PL, either by BSD or you. For more information on tagging paragraphs in SLE, see 
Creating a Link from an LME Product to a SpecLink-E Section. 

2. The SLE paragraph must be linked to an LME Product, but that Product does not have to 
be in an assembly or linked to a Revit Product. 

3. Click on the Products Dashboard.  
4. To activate the SLE paragraphs that are linked to Revit Objects (through Products and 

Assemblies) you can use Auto Select Specs. 
5. To activate other SLE paragraphs, you can place a checkmark in the Select Specs 

column.  
6. To exclude an SLE paragraph, place an X in the Select Specs column. Click twice in the 

Select Specs column to place an X. 
7. To remove all green squares in the Select Specs column, returning the boxes to neutral, 

toggle Auto Select Specs off. 
8. To implement the links in SLE, click on Synchronize. 

 
If an SLE paragraph is turned on due to a link from LME, the same link will be applied to the 
parent of the paragraph, all the way to the top of the section, turning on the section if necessary. 
If any of the intervening parents is subject to an Exclude condition, the chain will be broken just 
as in downward linking scenarios. To see the effects in your SLE project, you may need to click 
on Refresh Tree in the Project Tree tab. If any affected sections are checked out, they will need 
to be checked in for the LME links to take effect. Note that a user checkmark or X on an SLE 
paragraph will override any links from LME. 

Manage Groups 

Rename Group  

To rename a group, open the Summary Info dialog box from the Quick Access Toolbar or the 
Application menu. Type in the new name in the LME Group Name field and click Save.  

Saving Your Work  

Changes made in your SpecLink-E projects and Revit projects are saved in those applications. 
Changes made within your LME Groups are saved automatically to the LME Groups  Database 
where your LME Groups are stored. User added Products, Assemblies, Links and Keynotes are 
also stored in the LME Groups Database.  
   
When you make a backup of your SpecLink-E databases in SpecLink-E, that backup will include 
the LME Groups and LME Master database.  

Backing up and Restoring the Databases 

Backup Databases and Restore Databases must be performed in SLE Support Utilities on the 
Building Systems Design, Inc. group command. Backing up the SpecLink-E databases will 
include the LinkMan-E Master and LME Groups databases.  
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When you restore the SpecLink-E project database the LME Groups database will be included if it 
existed when the backup was created.  
 
For more information, see the SLE Help topics of Backup and Restore..  

Delete LME Group  

To permanently remove a group from your LME Groups database:  

1. With your LME Group closed, from the application menu choose Delete LME Group.  
2. When the dialog box opens, select the Group to delete.  
3. Click Delete.  
4. You will be asked to confirm the deletion.  

Note that deleting an LME Group deletes only the LME information about the connected projects 
but deletes nothing in either the SpecLink-E project or the Revit project.  

Add to the LME database 

Add New Product   

To create a new product:  

1. Click on the Products Dashboard tab. 
2. Click on the Applications tab and click on Show All Objects (so you can see your newly 

added products.) 
3. Highlight the folder in the tree where the product should be. 
4. Click on Add New from the Products Dashboard group on the Home tab. 

Alternatively, if there are Products in the right hand panel, you can right click on an 
existing Product and choose Create New Product. 
 

 
 

5. Fill in the information on the Add/Edit Product form: 
1. Folder - Filled in automatically, but can be changed to move the product to a 

different folder. Click on the field to bring up the Folder Selection Form to select a 
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different folder in the project. Double click on the newly selected folder to bring it 
into the Add/Edit Product form. 

2. Name - Fill in the Product name. 
3. Location, Prefix, Position, Suffix - These fields combine to form the Keynote #:  
4. Keynote # - Filled in by the software, based on the combination of the fields 

above. 
5. Keynote - Enter associated Keynote text. 
6. Notes - Fill in any additional notes about this product. 

6. Click Apply to save the product. 
7. Click Close to close the form. 

Duplicate Product   

To make a copy of an existing product:  

1. Click on the Products Dashboard tab. 
2. Highlight the folder in the tree that contains the product that you want to copy. 
3. Click on the product to be copied in the Products Dashboard.  
4. From the Home tab, Products Dashboard group, click on Duplicate. 

Alternatively, right click on the product and choose Duplicate Product. 
5. The Add/Edit Product form opens and you can make any required changes to the 

product, including moving it to a different location in the Products Dashboard tree. See 
Edit Product. 

Edit Product   

User added or copied products may be changed. To edit an existing user added product:  

1. Click on the Products Dashboard tab. 
2. Highlight the folder in the tree that contains the product that you want to edit. 
3. Click on the product to be edited in the Products Dashboard.  
4. From the Home tab, Products Dashboard group, click on Edit. 

Alternatively, right click on the product and choose Edit Product. 
5. The product form opens and you can make any required changes to the product, 

including moving it to a different location in the Products Dashboard tree.  

Notes  

Notes may be added on user added products and user added assemblies.  

Delete Product   

You can only delete user added Products. To delete a user added Product:  

1. Click on the Products Dashboard tab. 
2. Highlight the folder in the tree that contains the Product you wish to delete. 
3. Click on the Product in the Products Dashboard. 
4. From the Home tab, Products Dashboard group, click on Delete. 
5. Click Yes to confirm the deletion. 
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Add New Assembly   

To create a new assembly:  

1. Click on the Assemblies Dashboard tab. 
2. Click on the Applications tab and click on Show All Objects (so you can see your newly 

added assemblies.) 
3. Highlight the folder in the tree where the assembly should be 
4. Click on Add New from the Assemblies Dashboard group on the Home tab. Alternatively, 

if there are Assemblies in the right hand panel, you can right click on an existing 
Assembly and choose Create New Assembly. 
 

 
 

5. Fill in the information on the Assembly form: 
1. Folder - Filled in automatically, but can be changed to move the product to a 

different folder. Click on the field to bring up the Folder Selection Form to select a 
different folder in the project. Double click on the newly selected folder to bring it 
into the Add/Edit Assembly form. 

2. Name - Fill in the Assembly name. 
3. Location, Prefix, Position, Suffix - These fields combine to form the Keynote #. 
4. Keynote # - Filled in by the software, based on the combination of the fields 

above. 
5. Keynote - Enter associated Keynote text.  
6. Notes - Fill in any additional notes about this assembly. 

6. Click Apply to save the assembly. 
7. Click Close to close the form. 
8. To add Products to the assembly see Add Products to Assembly. 
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Duplicate Assembly   

To make a copy of an existing assembly:  

1. Click on the Assemblies Dashboard tab. 
2. Highlight the folder in the tree that contains the assembly that you want to copy. 
3. Click on the assembly to be copied in the Assemblies Dashboard.  
4. From the Home tab, Assemblies Dashboard group, click on Duplicate. 

Alternatively, right click on the assembly and choose Duplicate Assembly. 
5. The assembly form opens and you can make any required changes to the assembly, 

including moving it to a different location in the Assemblies Dashboard tree. See Edit 
Assembly. 

Edit Assembly   

User added or copied assemblies may be changed. To edit an existing user added assembly:  

1. Click on the Assemblies Dashboard tab. 
2. Highlight the folder in the tree that contains the assembly that you want to edit. 
3. Click on the assembly to be edited in the Assemblies Dashboard.  
4. From the Home tab, Assemblies Dashboard group, click on Edit. 

Alternatively, right click on the assembly and choose Edit Assembly. 
5. The assembly form opens and you can make any required changes to the assembly, 

including moving it to a different location in the Assemblies Dashboard tree.  
6. You can remove a product from an assembly be clicking on it and choosing Remove 

Product. 
7. You can also Add Products to an Assembly.  

Delete Assembly   

You can delete user added assemblies only. To delete a user added assembly:  

1. Click on the Assemblies Dashboard tab. 
2. Click on the assembly that you want to delete in the Assemblies Dashboard. 
3. Click on Delete in the Assemblies Dashboard group on the Home tab. 
4. Click Yes to confirm the deletion. 

Add Products to Assembly  

When you have created a new assembly, use the following steps to add products to the 
assembly:  

1. Leave the assembly form open. Note: If you have closed the assembly form, right click on 
the assembly and choose Edit Assembly. 

2. Right click on the Products Dashboard and choose New Vertical Tab Group or New 
Horizontal Tab Group. 
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3. In the Products Dashboard window, find and click on the Product you want to add to the 
assembly. 

4. Drag and drop the product into the Products window on the bottom part of the assembly 
form. 

5. Repeat the steps for as many products as needed for this assembly. 
6. If you add a Product by mistake, click on the product in the Assembly form and click on 

Remove Product. 
7. Click Apply and Close when done. 

Links 

Viewing Links  

You can view links that are supplied with the LME database, as well as links that you have added. 
In the Products and Assemblies Dashboards, right click on the Product or Assembly and choose 
Edit Links. In the Revit or SpecLink Project tabs, right click on the Revit object or SLE paragraph 
and choose View Links. The Add/Delete Link dialog box opens.  

·  Description - This is the name of the item to which this record is linked. 
·  App - This is the application that the linked item belongs to. 
·  Type - There is an M if the link is a Master link. There is a P if the link is a User-Added 

(Project) link. 
In the Products Dashboard, the Links dialog box will also display:  

·  SLE Section - The Section number and acronym of the SLE Section for this SLE 
paragraph. 

·  SLE Seq # - the Sequence number in SLE for this SLE paragraph. 

Linking User Added Assemblies and Products   

The data that is included in the master data installed with LME already includes links, but you will 
need to add links when you add assemblies and products.  
   
There are two types of links that you can add:  
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·  Links from an object in a Revit project to a LME assembly. 
·  Links from a product to a SpecLink-E project. 

Creating a Link from an LME Product to a 
SpecLink-E Section  

User added sections and paragraphs in your SpecLink-E project will not be pre-linked to the LME 
Products. Each SLE paragraph can only have one link with a single LME Product. To change a 
link, you must delete the existing link first before adding a new one. Product Links must be added 
or deleted in the Products Dashboard.  

To create a link from an LME Product to a SpecLink-E paragraph:  

1. Add the paragraph to your SpecLink-E project if it does not already exist. 
2. Using the View tab/Status Columns group in SLE, make sure that the Requirements Tags 

and User Defined Tags columns are visible. 
3. If this is a User created paragraph in SLE, right click on the R column and apply the PL 

(Product) tag. 
4. If this is a Master paragraph in SLE (or the R column is already in use) right click on the 

U column to apply the PL tag. (The U column can be used to apply the PL tag to both 
BSD Master and User paragraphs.) 

5. In SLE, click on Save to Database or Check In and Close under the Documents tab. 
6. If the SLE paragraph is newly added or newly tagged, click on the Refresh icon in the 

Applications tab of LME.  
7. Use New Horizontal Tab Group or New Vertical Tab Group to display the SpecLink 

Project and the Products Dashboard in separate windows. 
8. In the tree of your SpecLink Project tab, click on the folder that contains the SpecLink-E 

paragraph that you want to link. 
9. In the tree of your Products Dashboard tab, click on the folder that contains the product 

that you want to link. 
10. Drag the SLE paragraph and drop it on the LME product. 
11. The Add/Delete Link form opens to display the link that you just created. 
12. Click on Apply and then Close. 
13. You will now see a checkmark in the Linked column for this paragraph in the SpecLink 

Project tabs. 

Creating a Link from Revit to an LME Assembly  

User added objects in your Revit project will not be pre-linked to the LME Assemblies. To create 
a link from a Revit object to a LME Assembly:  

1. Add the object to your Revit project if it does not already exist. 
2. If you added a new object in your Revit project, in your Revit project, click on Update 

LinkMan-E data from the LinkMan-E menu. 
3. Use New Horizontal Tab Group or New Vertical Tab Group to display the Revit Project 

and the Assemblies Dashboard in separate windows. 
4. In the tree of your Revit Project tab, click on the folder that contains the Revit object that 

you want to link. 
5. In the tree of your Assemblies Dashboard tab, click on the folder that contains the 

assembly that you want to link. 
6. Drag the Revit object and drop it on the assembly. 
7. The Add/Delete Link form opens to display the link that you just created. 
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8. Click on Apply and then Close. 
9. You will now see a checkmark in the Linked column for this object in the Revit Project 

tab. 

Editing Links   

Master Links can be viewed using Edit Links. Only User added links may be edited. To view a 
master link or edit a user added link:  
 

 

1. Click on the tab where the link is, which is either the Products Dashboard or the 
Assemblies Dashboard. 

2. Click in the tree on the folder that contains the object with the link. 
3. Click on the object (assembly or product) that contains the link. 
4. Right click on the object and choose Edit Links. 
5. You can view any link or delete a user added link. 

Deleting User-Added Links  

Master links cannot be deleted by users. To delete a user-added link:  
   
In Products:  

·  Click on the Products Dashboard tab. 
·  Highlight the Product that includes the link that you want to delete. 
·  Right click on the Product and choose Edit Links. 
·  Click on the link that you want to delete and click on Delete Selected Link. 

   
In Assemblies:  

·  Click on the Assemblies Dashboard tab. 
·  Highlight the Assembly that includes the link that you want to delete. 
·  Right click on the Assembly and choose Edit Links. 
·  Click on the link that you want to delete and click on Delete Selected Link. 
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Export for Printing  

Export for Printing exports the records currently displayed in the Document Panel  to an XML 
file which is automatically opened in Excel.  
 

·  Select the tab (Products Dashboard, Assemblies Dashboard, Revit Project or SpecLink 
Project) that includes the records that you want to export. (The Keynotes tab records 
cannot be exported at this time.) 

·  Click on the folder within the tab that includes the records you want to export. Leaving the 
cursor on the top level folder will export all the records within that tab (SpecLink Project 
and Revit Project tabs only). 

·  Click on Show All Objects, Show Active Objects, Show Discrepancies, etc. as desired.  
·  Click on the LME button and select Export for Printing. 
·  Change the destination folder in the Select File for export dialog box to place your 

exported file in the desired location. 
·  Click Save. 
·  If you are using Office 2007, you may see this message: 

 
·  Click Yes. 
·  You will see a menu with the choice of opening the file as an XML list, a read-only 

workbook or using the XML Source task pane. 

 
·  If you choose As an XML list, an XML list is created in a new workbook. The contents of 

the file are imported into the XML list. Microsoft Excel will infer the schema of the XML 
data file. This choice will probably be the most useful to you. You can sort the records by 
any of the individual columns. Since the file was originally an XML file, if you want to save 
it as an Excel file, you will need to give it a name when you save it.  

·  If you choose As a read-only workbook, The XML data file is opened as a read-only 
workbook. The structure of the file is flattened. 

·  If you choose Use the XML Source task pane, the schema of the XML data file is 
displayed in the XML Source  task pane. You can then drag elements of the schema to 
the worksheet to map those elements to the worksheet. 

·  If you get a message that the XML source file does not refer to a schema, click OK. 
·  When your file opens, you can sort it by any column. You can also print and/or save the 

file as an Excel spreadsheet and continue to work with it, adding a header and/or footer if 
desired.
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Revit Keynote Management System 

The Basics 

LinkMan-E includes a Revit Keynote Management System to allow you to manage the keynotes 
in your Revit project. LinkMan-E’s keynote utility will display the keynotes that are assigned to the 
elements in the Revit project, compare these to master keynotes provided in LinkMan, and allow 
you to edit and copy keynotes. Once the keynotes are in acceptable shape, you can import the 
keynotes and keynote file from LinkMan-E, replacing any existing keynotes in your Revit project 
and allowing placement of additional keynotes. 
 

Revit Keynoting Concepts 

The LME Keynote Management System uses Revit’s keynote tagging functions which store data 
in two locations: 1) the keynote number is stored in the Revit project in the element’s Keynote 
attribute (under Identify Data); 2) the keynote text is stored in the Revit Keynotes File, a text file 
with the full list of keynotes available for assignment to elements. Although any keynote number 
may be saved on an element, the only keynote text that will be displayed in a keynote tag is that 
which exists in the keynotes file and which corresponds to the keynote number in the element. 
There may be one or more keynotes files, depending on the settings in each Revit instance. For 
efficiency and quality control, most multi-user set-ups of Revit use the same keynotes file. When 
assigning new or revised keynotes, LME exports a new keynotes file for Revit’s use. 
 
Background on Keynotes 
Not everyone in architecture and engineering uses keynotes, and for good reasons: 1) employing 
them effectively requires training the drafting staff and applying strict discipline; 2) there are no 
standards, so frequently the keynotes vary from project to project (as well as from office to office); 
and 3) managing keynotes without the use of specialized software is difficult or impossible.  
 
Why Use Keynotes?  
Not everyone even knows what they are. Keynotes are short notations intended for use on 
construction drawings -- especially drawing details -- that take the place of verbose, sometimes 
conflicting or contradictory ad hoc notes. They typically consist of a specification section number 
in combination with a short suffix, so the contractor is referred both to a numerically organized 
legend on the drawings and to the appropriate specification sections for more detail. For example, 
a keynote 042000.A might correspond on a legend to ”Clay Facing Brick,” and a keynote 
042000.B might correspond to ”Common Brick.” The contractor would then be expected to go to 
Section 042000 - Unit Masonry in the specifications to find the detailed requirements for clay 
facing brick and common brick. Of course, for maximum effectiveness, the keynote number 
should correspond exactly with the section number in the specifications, and the terms in the 
drawing legend should correspond exactly with the terms used in the specification section. 
 
One of the problems associated with keynotes is the lack of a definitive standard, so ”042000.A” 
might mean something totally different on the next project and would almost certainly mean 
something different at the next firm. Learning to use predefined keynotes instead of creating 
notes on the fly and having the discipline to apply them consistently throughout a firm requires a 
lot of effort. In addition, it helps to have specialized software for placing the keynotes, managing 
them to prevent conflicts, and generating accurate legends that can be placed and updated 
easily. 
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Revit and LinkMan-E Jointly Manage Keynotes 
Autodesk’s Revit does have keynoting capability, including automated generation of keynote 
legends, but it has never been easy to create, assign, or make use of the keynotes. Now BSD 
LinkMan-E includes features that will help manage the keynotes more effectively. Think of 
LinkMan-E as a keynote editor, organizer, and assignment tool. Think of Revit as a keynote 
placement and updating tool. Together, they comprise a coordinated system for keynoting. 
 
When we connect a Revit project to a LinkMan-E Group and click on Update LinkMan-E Data, 
Revit sends to LinkMan information about elements and materials currently included in the model. 
When we Refresh the data in LinkMan-E, this data is displayed on the Revit Project tab. The 
Revit data displayed includes any keynotes included in the model, plus any corresponding 
LinkMan-E keynotes. It is possible to modify the keynotes in the Revit columns (keynote number 
in one column, and keynote text in the other), but the LinkMan master keynotes cannot be 
altered. Right clicking on any element allows us to copy the LME default keynote to the Revit 
keynote column. There is also a command -- Apply Default Keynotes -- that will automatically 
copy all the master keynotes to any blank fields in the Revit column, without overwriting any 
keynotes that already exist.  In other words, with this command we can easily merge existing 
project keynotes with master keynotes. There are also other ways to create or modify the project 
keynotes, which are covered in the Basic Steps below. Why would anyone want to do this? It’s 
really very simple: When the Import/Replace Keynotes command in Revit is clicked, any keynotes 
in the R columns in LinkMan-E will automatically be assigned to the corresponding elements in 
Revit and will replace any keynotes that may have already been placed in the Revit project. This 
is a far more efficient way to assign and update keynotes than would be possible within Revit, 
where keynotes must be individually assigned to each element. 
 

Basic Steps 

To make use of the Revit Keynote Management System, you will use these basic steps: 

·  Optionally: You can begin by Importing a Keynotes file from your Revit project. 
·  Viewing the Revit Keynotes - See Keynotes Tab, Keynote Display in the Revit Tab and 

Keynote display in the Revit Materials tab. 
·  Creating new Keynotes - See Creating Keynotes in LinkMan-E and Editing Keynotes. 
·  If you have created Keynotes in LME (independent of a Product or Assembly) you can 

Assign a Keynote to a Revit Element or Material. 
·  Applying Keynotes to Revit Elements - See Apply Default Keynotes. 
·  Assigning the Keynotes file in Revit - See Import/Replace Keynotes and Accessing the 

New LME Revit Keynotes File in Your Revit Project. 
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Keynotes Tab 

 
 
The Keynotes tab displays keynotes that are included in the LME master database, as well as 
any keynotes you have added in LME. There are two top level folders in the tree. The 
MasterFormat folder displays the keynotes that have been assigned to the Products in the LME 
database, as well as any user added keynotes that have been added in that folder. The Uniformat 
folder includes LME master keynotes that have been assigned to assemblies in the LME master 
database, as well as any user added keynotes you have added under that folder.  
 
As you click on different folders, the keynotes displayed will reflect the contents of the folder you 
have selected. If you click on the MasterFormat04 folder, you will see all the keynotes that are 
included in all the folders below that folder. If you expand the folder and click on a lower level 
folder, you will see only the keynotes for that folder. 
 

Keynote Display in the Keynotes Tab 

The following fields are displayed in the Keynotes tab: 
·  Keynote Number 
·  Keynote Text 
·  Origin - M for Master, U for User added or imported 
·  LME Object Name - Name of the LME Product or Assembly to which this keynote is 

assigned. This is blank if the keynote was added in the Keynotes Tab, rather than when 
adding or editing a Product or Assembly.. 

·  LME Object Origin - Master if supplied in the master or User if user added. 
·  LME Object Type - Product or Assembly 

 
Note that the LME Keynote Number and LME Keynote Text fields are also displayed in the 
Products and Assemblies dashboards for the appropriate Products and Assemblies. 

Keynote Display in the Revit Tab 

When you click on the Revit Project tab in your LME group, you will see, for each Revit element in 
your project: 

·  R-Keynote # - Displays the keynote number for the keynote that is currently assigned -- 
or the keynote that is ready to be assigned by LME. 
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·  R-Keynote - Displays the keynote text for the keynote that is currently assigned -- or the 
keynote that is ready to be assigned by LME. Since Revit only stores the keynote number 
in the object (not the keynote text) the R-Keynote column may be empty if a keynote was 
applied in Revit, but that keynote file was not imported into LME. 

·  L-Keynote # - Displays the keynote number for the keynote that is currently assigned to 
the LME object this Revit element is currently linked to. This is a suggested keynote from 
the LME master or from an LME object that you have created. This keynote number can 
be transferred to the R-Keynote column singly (with a right mouse button click) or as a 
batch process using the Apply Default Keynotes in the Autodesk Revit group on the 
Applications tab. 

·  L-Keynote - Displays the keynote text for the L-Keynote # described above. This can be 
transferred to the R-Keynote column singly (with a right mouse button click) or as a batch 
process using the Apply Default Keynotes in the Autodesk Revit group on the 
Applications tab. 

 

Creating Keynotes in LME 

Adding a Keynote for a Product or Assembly 

If you want your keynote to be automatically assigned to a user-added LME Product or LME 
Assembly, the easiest way to do that is to add the keynote information while adding or editing the 
Product or Assembly. The Add/Edit Product or Assembly form displays the folder where the 
product or assembly is. The following fields are added or edited in this form: 

·  Folder - filled in by the software, based on where your cursor is when you add the 
Product or Assembly 

·  Name - User added name for the Product or Assembly 
·  Location, Prefix, Position, Suffix - These fields combine to make the Keynote #. 
·  Keynote # - The combination of the fields above. 
·  Keynote - User added description for the keynote. 
·  Notes - User added notes for this Product or Assembly. 

 

Adding a Keynote Independently of a Product or Asse mbly 
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Keynotes can be added in the Keynote tab. Highlight the folder in the tree where the keynote 
should be, click on the Home tab, and select Add New in the Keynotes group. Click Apply when 
the entry is complete. The following fields are in the Add Keynote Independent of an LME Object 
form: 

·  Folder - filled in by the software, based on where your cursor is when you add the 
keynote. Click on the field to bring up the Folder Selection Form to select a different 
folder in the project. Double click on the newly selected folder to bring it into the Add 
Keynote form. 

·  Location, Prefix, Position, Suffix - These fields combine to make the Keynote #. 
·  Keynote # - The combination of the fields above. 
·  Keynote - User added description for the keynote. 

 
Keynotes created in this way will not be associated with an LME object but they can be assigned 
to a Revit Element or Material. 
 

Editing Keynotes 

Only User added keynotes can be edited. To edit a user added keynote: 
·  Highlight the keynote to be changed. 
·  Right click on the keynote and choose Edit Keynote. 
·  Make the desired changes. 
·  Click OK to confirm. 

Deleting a Single Keynote 

Only User added keynotes can be deleted. To delete a user added keynote: 
·  Highlight the keynote to be deleted. 
·  Right click on the keynote and choose Delete Keynote. 
·  Click OK to confirm. 

Import Keynotes from Revit into LME 

The Import Keynotes icon on the Keynotes tab opens a dialog box that allows you to enter a file 
name or browse for a file, such as a user-generated master keynote file, and import it into 
LinkMan-E. When the correct file has been located, clicking on the Import button will 
automatically merge the data with the LME master keynotes, ordering them numerically. The 
imported keynotes are differentiated from master keynotes by a ”U” for user in the Origin column. 

Deleting All User Keynotes 

This function allows you to delete all user added or imported keynotes. Note that because the 
keynotes are shared among all LME groups, it will delete all user keynotes from all of your  
LME groups . A user keynote is any keynote that is not supplied with the LME master database. 
They can be created in LME or imported from a Revit Keynote file. If there is any chance that you 
might want to use these keynotes in the future, it is best to make a copy of the keynote file. Do 
this in Revit, using the Import/Replace Keynotes | All Keynotes function from the Add-Ins tab in 
Revit. Save the file with a name and in a location that you will be able to find later. If you want to 
bring the file back into LME, you can use the Import function in the Keynotes group in LME.  

To delete all user keynotes: 
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·  If a backup is desired, open your Revit project in Revit and make a backup of your user 
keynotes by using the Import/Replace Keynotes | All Keynotes function from the Add-Ins 
tab in Revit. 

·  To remove all User Keynotes in LME, click on the Keynotes tab. 
·  From the Home tab, Keynotes group, click on Delete User Keynotes. 
·  Note that this will delete all user keynotes from all of your LME groups. 
·  Click Yes to confirm. 

Assigning a Keynote to a Revit Element or Material 

To assign a keynote to a Revit Element or Revit Material: 
·  Open the Keynotes tab. 
·  Right click on the Revit Project or Revit Materials tab and choose New Horizontal Tab 

Group or New Vertical Tab Group. 
·  Locate the keynote to be assigned in the Keynotes tab. 
·  Locate the Revit Element or Revit Material to which the keynote is to be assigned. 
·  Drag and drop the keynote from the Keynotes tab to the appropriate Revit Element or 

Material. 

Removing a Revit Keynote from a Revit Element or Ma terial 

Once you have added a Keynote in the Keynotes tab, you can assign it to a Revit Element or 
Material. 
To remove a keynote from a Revit element or Material, right click on the Revit Element or Material 
and choose Remove Revit Keynote. 
 

Apply Default Keynotes 

Once you have reviewed and added any keynotes desired, you can use Apply Default Keynotes 
to copy keynotes from the LME keynotes to the Revit keynotes, in preparation for sending the 
information back to your Revit project. Applying the Default Keynotes will not overwrite any 
keynote numbers or keynote text already in the two Revit columns but will copy information from 
the L-Keynotes # column and the L-Keynote column to any empty fields in the R-Keynote # and 
R-Keynote columns.  
 
You can also apply a default keynote on a single record, by right clicking on the Revit Element 
and choosing Apply Default Keynote (This element). 
 

Import/Replace Keynotes from LME into Revit 

Once you have the R-Keynote # and R-Keynote columns completed, you can bring the 
information into your Revit project. 

·  In Revit, open the Revit project that is linked to your LME Group. 
·  Click on the Add-ins tab. 
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·  In the LinkMan-E group, select Import/Replace Keynotes.  

 
·  Your options are: 

o ”All Keynotes” includes all LinkMan-E master keynotes, all project keynotes (the 
keynotes in the R-Keynote # and R-Keynote columns in the Revit Project tab of 
LME), and all user keynotes that have been imported into or added in LinkMan-E. 
All these keynotes are organized automatically into a single file in numerical 
order. 

o ”All Master and Active User Keynotes” is the same as ”All Keynotes” except that 
user keynotes that are not in the R-Keynote # and R-Keynote columns are 
excluded (user keynotes are any marked ”U” that have been imported into or 
added in LinkMan-E). 

o ”Project Keynotes” includes only those keynotes that are currently in the Revit 
keynote columns, whether they are active or not – including any that have been 
copied from the LinkMan-E master keynotes or the user keynotes. 

·  Regardless of which choice is made, any keynotes in the R columns in LinkMan-E will 
automatically be assigned to the corresponding elements in Revit, replacing any 
keynotes that may have already been placed in the Revit project. However, the choices 
will determine what additional information – if any – will be imported into the text file that 
can be used for subsequent keynote selection and placement. That, in turn, depends on 
how much latitude the Revit users will be given for selecting and placing additional 
keynotes 

·  To allow the keynote text to show in Revit keynote tags, a new LME Revit Keynotes File 
is now exported. You will be asked to confirm the name and location of this file. The 
simplest procedure is to browse to the location of the current keynotes file and select the 
same file name -- this will overwrite the current keynotes file with the newly exported file. 

·  Click Save. 
·  This must be followed by Accessing the New LME Revit Keynotes File in Your Revit 

Project. 

Accessing the New LME Revit Keynotes File in your R evit 
Project 

To associate the LME Keynotes file with your Revit Project, allowing the keynote text to show in 
Revit keynote tags, follow these steps. 

·  Export the new file using the same path and file name as the old file (see Import/Replace 
Keynotes). Following the saving of the new file, starting Revit will automatically access 
the new file. Revit users who have Revit open when the new file is saved will have to 
either close and re-open Revit or follow the procedure below. 

·  Re-set the path to the new keynotes file. Note that this step must be done each and 
every time that you make a change to your LME keyno te file, even if you replace 
your existing file when using Import/Replace Keynot es (unless you close and re-
open Revit). 

·  After using Import/Replace Keynotes, click on the Annotate tab. 
·  Click on the Tag group title. 
·  Click on Keynoting Settings. 
·  Click on the Browse button to the right of the Full Path field. 
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·  Select the LME Revit Keynotes File that was created and click Open (if you overwrote the 
existing file, select that file and click Open). 

·  Click OK to close the dialog box.. 
 

To View a Keynote on a Revit Element While in Revit  

·  Find the element in the Project Browser. 
·  Right click on the element and choose Type Properties. 
·  The Keynote will be displayed in the Identity Data section of the form. 
·  Click on the Browse button at the end of the Keynote field to see the location of the 

keynote in the hierarchical structure of the keynote file. 
·  Individual Keynotes may be changed in this form. 
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Navigation and Miscellaneous Commands 

Folders 

The trees for the views in LME display the data in folders. The Products Dashboard and the 
SpecLink Project Views are in CSI's MasterFormat 2004 hierarchy. The Assemblies Dashboard 
uses a Uniformat hierarchy, and the Revit Project uses a proprietary hierarchy. The Keynotes Tab 
used both CSI MasterFormat as well as Uniformat. To open a branch in any of the trees, click on 
the plus sign adjacent to the folder.  

Shortcut Keys 

LinkMan-E uses several of the standard Windows keyboard shortcut keys: 
·  Control+X - Cut  - Use this to cut text for moving to a new location 
·  Control+C - Copy  - Use this to copy text for moving to a new location 
·  Control+V - Paste  - Use this to paste copied or cut text to a new location 

 
In addition, if you use the Alt key followed by the first letter of a tab (such as Alt and then T for 
Tools tab) the shortcut key abbreviations for the commands on that tab appear on the menus. 
Type the key for the command you want. Do not hold the Alt key down when you type the key for 
the desired tab. 

Vertical and Horizontal Tab Groups  

To separate two or more tabs into separate windows so you can see both (or more) at the same 
time, create a new Vertical or Horizontal Tab Group.  

·  Right click on the Tab of one of the views and choose New Vertical Tab Group or New 
Horizontal Tab Group.  

·  To move a tab from one group to the next, right click on it and choose Move to Previous 
Tab Group or Move to Next Tab Group.  

Right mouse button menu in the Assemblies 
Dashboard 

The right mouse button in the Assemblies Dashboard includes the following choices, depending 
on the situation. 
 

·  Create New Assembly 
·  Edit Assembly 
·  Duplicate Assembly 
·  Edit Links 
·  Delete Assembly 
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Right mouse button menu in the Products 
Dashboard 

The right mouse button in the Products Dashboard includes the following choices, depending on 
the situation. 
 

·  Create New Product 
·  Edit Product   
·  Duplicate Product 
·  Edit Links   
·  Delete Product 

Show All Types 

 
 
The Show All Types command on the Applications tab, is available while clicked on the Revit 
Project tab. Clicking on Show All Types will show all families and types under the folder that is 
currently highlighted in the Revit Project Tree, whether they are active in the linked Revit project 
or not.  
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Show Active Types 

 
 
The Show Active Types command, on the Applications tab, is available while clicked on the Revit 
Project tab. Clicking on Show Active Types will show only those families and types that are active 
in the linked Revit project, under the folder that is currently highlighted in the Revit Project Tree.  

Show All Products   

 
 
The Show All Products command on the Applications tab, is available in the SpecLink Project tab. 
Clicking on Show All Products will show all products under the folder that is currently highlighted 
in the SpecLink Project Tree, whether they are active in the linked SpecLink-E project or not. 
Note that for a section to appear in the SpecLink Project Tree you must have checked it out once 
or have a link to it.  
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Show Active Products   

 
 
The Show Active Products command, on the Applications tab, is available in the SpecLink Project 
tab. Clicking on Show Active Products will show only those products that are active in the linked 
SpecLink-E project, under the folder that is currently highlighted in the SpecLink Project Tree.  

Show All Objects   

 
 
The Show All Objects command on the Applications tab, when clicked while in the Assemblies 
Dashboard tab, shows all assemblies under the folder currently highlighted in the Assemblies 
Dashboard tree, whether they are active in any of the linked projects or not.  
When clicked while in the Products Dashboard tab, it shows all products under the folder 
currently highlighted in the Products Dashboard tree, whether they are active in any of the linked 
projects or not.  
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Show Active Objects   

 
 
The Show Active Objects command on the Applications tab, when clicked while in the Assemblies 
Dashboard tab, shows only the  assemblies under the folder currently highlighted in the 
Assemblies Dashboard tree, that are active in any of the linked projects.  
When clicked while in the Products Dashboard tab, it shows only active products under the folder 
currently highlighted in the Products Dashboard tree.  

Refresh  

The Refresh command on the Applications tab will bring in the most current information from both 
your Revit Project and your SpecLink-E project. It does not send any data to your SpecLink-E 
project. To initiate links in your SpecLink-E project use Synchronize.  
Note that you are not guaranteed you have the latest data from Revit unless you (or someone) 
goes into the Revit project and uses the Update LinkMan-E Data command to send the latest 
Revit data to the LME database. This step needs to be performed before the Refresh command.  

Show Discrepancies 
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Available on the Applications tab while on the Products Dashboard or the Assemblies Dashboard 
tab, clicking on Show Discrepancies displays only those Assemblies or Products that are active in 
one linked project but not another. An object must be linked to another application to appear in 
the Show Discrepancies view. If you have this setting on, and you use Synchronize, objects may 
disappear once they become active in SpecLink-E and are therefore no longer discrepancies. 

Auto Select Specs   

 
 

The Auto Select Specs command is available in either the Products Dashboard or the Assemblies 
Dashboard tab. It will put a green background in the Select Specs column for all products in the 
LME Group that are linked with SLE paragraphs. This command works the same whether you 
initiate it from the Products Dashboard or the Assemblies Dashboard. Auto Select Specs is a 
toggle, so that you can turn it on or off by clicking on the menu command. The setting of on or off 
is saved with each project. It defaults to off when you begin a new LME Group.  

Alternatively, you can check products individually. See Activating SLE paragraphs and sections.  

Once the selections have been made, clicking on Synchronize will activate the links to the 
appropriate sections and paragraphs in the SpecLink-E project. If you deselect Auto Select Specs 
and then Synchronize, paragraphs that were activated by links from LME will no longer be 
activated by LME links.  

Synchronize  

The Synchronize command on the Applications tab/BSD SpecLink-E Group will:  

1. Send data from your LME Group to your SpecLink-E project, specifically the status of the 
Select Specs column in the Products Dashboard.  

2. Wait for the SLE server to reflect the changes in the SLE project. 
3. Do a Refresh so that your LME Group displays the new current status of your SLE 

Project as well as your Revit project. 
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If you simply want to see the current status from your SLE and Revit projects, Refresh is the 
faster method since it does not send any data from your LME projects database to your SLE 
project.  
Note that you are not guaranteed you have the latest data from Revit unless you (or someone) 
goes into the Revit project and uses the Update LinkMan-E Data command to send the latest 
Revit data to the LME database. If necessary, do this before using Synchronize.  
   
The following condition needs to be in place for Synchronize to activate paragraphs in your SLE 
project:  

·  The SLE paragraph needs to be linked to a product in the LME Products Dashboard. 

Closing the software 

Click on the X in the top right corner of the application. If you have a LME Group open, it will be 
closed automatically.  
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Getting Help 

Accessing and Using Help  

Help is right at your fingertips. There are two ways to access Help:  
   
F1: At any time press F1 to open Help.  

Help Icon:  Click the Help icon  at the top right of the application window.  
   
Help has three tabs:  

·  Contents:  Displays the Help contents. From the Contents list, choose the topic closest to 
what you need. Click on a topic to read it. 

·  Index:  Displays a list of all Help topics in alphabetical order. 
·  Search: Type any word or phrase and then click on List Topics. All topics containing the 

word or phrase will be listed in the window below. 

If you can't find what you need in the Help file, call Tech Support at 800-266-7732.  

Electronic User Manual  

The User Manual is available in electronic format and may be downloaded from our Download 
Center and then printed or loaded onto your hard drive. Using the "find" feature in the PDF 
Reader edit menu offers you a quick way to "thumb through" the manual electronically, to find 
something you might remember reading but cannot find in the paper version.  

Working around time outs 

If your SpecLink-E Projects database is over 1.25 GB in size (as shown in the SpecLink-E 
About dialog accessible from the Application Menu) you can shrink it by saving older projects 
to files and deleting them from the database.  

You can try running the SpecLink-E command Tools | Rebuild Project Links one or more 
times to speed up the linking process for the SLE project.  

In the SpecLink-E Help, view the topic called Server Database Maintenance. 
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Customer Support  

For assistance in installing or using LinkMan-E, contact customer support at:  

·  Call toll free: 1-800-266-7732 or 404-365-9226  
·  FAX: 1-404-365-8912  
·  Email: support@bsdsoftlink.com  

Tips:  

·  Support is located in Atlanta (Eastern Time [ET]), and office hours are 8:30 a.m. to 5:30 
p.m., on normal business days. 

·  You can also download the latest copy of the software and the user manual from our 
Download Center.  
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